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Participant Funding Program – Appendix A 


What Needs to be Included in a Resolution 
 


You must provide a valid signed resolution (corporate or Band Council) or document 
authorizing the Applicant to act on behalf of their organization for the purpose of this 
application and, if successful, a Contribution Agreement.  


A valid and signed resolution should include: 


• The [Name of the governance body] (i.e. Board of Directors, Governing Council, Band 
Council, etc.): 


• Authorize [Name of the applicant] to enter into a Contribution Agreement with the 
Canadian Environmental Assessment Agency; and 


• Designate the duly authorized signatory(ies) to be [enter name or names here], on 
behalf of [Name of the applicant], for the purposes of signing the application for 
funding, the Contribution Agreement, or any other documents required under the 
Contribution Agreement. 


Note: If the signing authority is given to more than one individual, please specify what 
documents each of the individuals is authorized to sign on behalf of the Applicant; and if 
more than one individual is designated to sign a specific document, please specify whether 
one signature would be sufficient or if each of the individuals must sign. 


Signature block: should include signature(s) and title(s) of authorized signatory(ies) and 
the date of signature. 


Note: This must be provided at the same time as your application or within two weeks of 
submitting your application to the Agency. 
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Content and Expense Category Description 
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What is an Environmental Impact Statement? 


The Environmental Impact Statement is prepared by the proponent. The purpose of the 


Environmental Impact Statement is to: 


 identify the potential adverse environmental effects including cumulative effects of 


the proposed project; 


 propose technically and economically feasible measures to mitigate those effects; 


 evaluate whether the proposed project will result in any significant adverse 


environmental effects; and 


 describe a follow-up program. 


Examples of activities to review the Environmental Impact Statement 


The types of activities that may be necessary to review and provide written comments on 


the Environmental Impact Statement include: 


 reviewing the Environmental Impact Statement Summary or the Environmental 


Impact Statement and relevant documents; 


 meeting with the Applicant’s members to obtain their input on the Environmental 


Impact Statement Summary or the Environmental Impact Statement; 


 preparing written comments or a report on the Environmental Impact Statement 


Summary or the Environmental Impact Statement that will be provided to the 


Agency; and 


 any other relevant activities associated with the review and comment on the 


Environmental Impact Statement Summary or the Environmental Impact Statement. 


What is a Draft Environmental Assessment Report? 


The draft Environmental Assessment Report presents the Agency’s views of the findings of 


the environmental assessment, including conclusions and recommendations regarding the 


adverse environmental effects that are likely to result from the proposed project, 


appropriate measures that would mitigate those effects, the significance of residual effects 


after implementation of the mitigation measures as well as the components of the follow-up 


program. 


Examples of activities to review the Draft Environmental Assessment Report 


The types of activities that may be necessary to review and provide written comments on 


the draft Environmental Assessment Report include: 


 reviewing the draft Environmental Assessment Report and relevant documents; 


 meeting with the Applicant’s members to obtain their input on the draft 


Environmental Assessment Report; 


 preparing written comments or a report on the draft Environmental Assessment 


Report that will be provided to the Agency; and 


 any other relevant activities associated with the review and comment on the draft 


Environmental Assessment Report. 
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Expense Categories 


Note:  


If your funding request is successful, it will be important to keep all invoices and receipts accounting 
for your approved expenses. You will need these to request payment.  


The application review and decision process can take up to 30 days after we receive your application. 


If you are successful in receiving funding, you cannot request payment for any work done before a 
Contribution Agreement is fully signed by both you or your organization and the Agency. 


Reporting Costs 


Staff salaries 


The staff salaries category includes salaries and up to 20 percent in benefits of the salary 


amount requested of the participation coordinator and individuals employed by your 


organization or your Aboriginal community for the purpose of researching and preparing 


materials related to your organization’s or your Aboriginal community’s participation (e.g. 


research staff and secretariat services). 


Note: By signing the application, your organization or your Aboriginal community confirms 


that the requested funds for salaries are designated solely for time the individual dedicates 


to the preparation for and participation in the environmental assessment. For each 


individual, provide the employee’s name and his/her duties related to your organization, the 


number of hours spent on project-specific activities and the salary hourly rate. 


Administrative costs and office supplies/telephone charges 


The administrative and reporting costs include costs associated with bookkeeping, 


accounting, and reporting to the Agency on deliverables related to your organization’s or 


your Aboriginal community’s participation in the environmental assessment. As well, this 


category includes costs related to interfacing with the Agency on requests for payments 


specific to your organization’s or your Aboriginal community’s participation in the 


environmental assessment. 


Any administrative and reporting expenses that do not support your organization’s or your 


Aboriginal community’s participation in the environmental assessment, including normal 


bookkeeping and accounting, are not eligible for funding under the Participant Funding 


Program (the Program). 


The costs of office supplies include costs which are important to support your organization’s 


or your Aboriginal community’s participation in the environmental assessment (e.g. 


photocopying, postage and telephone charges). 


Any operations and maintenance expenses that do not support your organization’s or your 


Aboriginal community’s participation in the environmental assessment, including normal 


supplies and overhead costs, are not eligible for funding under the Program. 


Provide a brief explanation of the need for the specific administrative and reporting 


expenses and for the specific supplies. 
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Office rental space and meeting rooms 


The rental of office space and meeting rooms category includes costs associated with 


renting an office space, meeting rooms and office equipment that directly relates to your 


organization’s or your Aboriginal community’s participation in the environmental 


assessment. 


Any operations and maintenance expenses that do not support your organization’s or your 


Aboriginal community’s participation in the environmental assessment, including normal 


rent and overhead, are not eligible for funding under the Program. 


Describe the need to rent the facilities and provide details on the event and rental costs. 


Local collection or distribution of information (excluding general media advertising 


and promotion) 


The collection or distribution of information category is specifically for costs associated with 


gathering information and concerns from your organization’s membership or your Aboriginal 


community members as well as sharing relevant information related to the environmental 


assessment with your membership or members. 


Provide a brief explanation of the need to collect or distribute the information. Indicate from 


and to whom the information will be distributed and collected. Explain how this action will 


contribute to the objectives of the environmental assessment. 


General media advertising and promotion 


The general media advertising and promotion covers advertising and publication costs for 


meetings held by your organization or your Aboriginal community specifically for your 


membership or your members with the purpose of gathering their input and concerns as 


well as sharing relevant information related to the environmental assessment. Examples of 


costs covered in this category include posters and newspaper advertisements. 


The advertisement and promotion of your organization’s or your Aboriginal community’s 


meetings must have a specific purpose not already addressed by other parties involved in 


the environmental assessment responsible for promoting awareness of the environmental 


assessment and public participation opportunities (e.g. Agency or proponent). 


Provide a brief explanation of how this action will contribute to the objectives of the 


environmental assessment and the intended audience. 


Other expenses 


Any other expense item that your organization or your Aboriginal community believe is 


needed to support your participation in the environmental assessment may possibly be 


covered by the other expense categories, subject to approval by the Agency. 


The request must be supported by a clear explanation of how this item or action will 


contribute to the objectives of your organization’s or your Aboriginal community’s 


participation in the environmental assessment. 
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Professional services 


Professional fees 


The professional fees category includes the daily rates and expenses for expert advice or 


assistance on environmental, technical or social issues relevant to the environmental 


assessment. 


For each expert, identify the individual’s expertise and the relevance of this expertise to 


your organization’s or your Aboriginal community’s participation. 


Legal fees 


The legal fees category includes the daily rates and expenses for expert legal advice or 


assistance directly related to your organization’s or your Aboriginal community’s 


participation in the environmental assessment. The costs for legal advice are eligible under 


the Program, but legal representation at public participation events is not encouraged. 


Provide an explanation of why legal research or representation is important to your 


participation in the environmental assessment. 


Provide the name of a legal person/firm, nature of the work and its pertinence to the 


environmental assessment. 


Please note that there is a maximum amount cap on this category; please refer to Section 7 


of your application form for the specific amount. 


 


Travel expenses 


The travel expense category includes expenses related to travelling to attend public 


participation events held by the Agency as part of the environmental assessment. Such 


expenses may include transportation, meals, lodging and incidentals. Travel expenses must 


be reasonable and in accordance with federal government travel directives (http://www.njc-


cnm.gc.ca/directive/travel-voyage/index-eng.php).   


Explain why travelling to the event is necessary, and if applicable, why more than one 


person is needed to represent your organization or your Aboriginal community. Details 


should be provided regarding travel mode, accommodation and duration. 



http://www.njc-cnm.gc.ca/directive/travel-voyage/index-eng.php

http://www.njc-cnm.gc.ca/directive/travel-voyage/index-eng.php

http://www.njc-cnm.gc.ca/directive/travel-voyage/index-eng.php
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Honoraria for Elders and ceremonial offerings 


The honoraria for Elders category includes the daily rates associated with your Aboriginal 


community Elders providing Aboriginal traditional knowledge or community knowledge 


relevant to the environmental assessment. The Elders cannot be in receipt of any other 


salary or direct income for the activity for which an honorarium is claimed. 


The ceremonial offering includes relevant costs associated with providing gifts, such as 


tobacco offered to Elders, in recognition of having provided Aboriginal traditional knowledge 


or community knowledge relevant to the environmental assessment. 


Provide the names of the Elders, the honoraria rate, date and purpose of the meeting, or 


function of the Elders and describe the nature of the ceremonial offering and its relation to 


the environmental assessment. 


Please note that there is a maximum amount cap on this category; please refer to Section 7 


of your application form for the specific amount. 
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Checklist for Completing the Funding Application Form 
 


 The complete application is submitted on or before the application deadline. 


 Section 3 (Applicant Contact Person) is complete. 


 A category in Section 4 (Applicant Type and Information) has been selected. 


 If the Applicant represents an unincorporated organization or Aboriginal group, 
supporting documentation (resolution) identifying the Applicant as the representative of 
the organization or group is attached to the application. 


 Section 5 (Eligibility Criteria) is complete. 


 Section 6 (Administrative Information) is complete. 


 Section 7 (Public Participation Opportunities) is complete for each participation 
opportunity by indicating your funding request and explaining how your proposed 
funding will be spent. 


 The funding requested in Section 7 (Public Participation Opportunities) does not exceed 
the maximum funding available for each Participation Opportunity. 


 There are no calculation errors in the budget and supporting information is provided 
corresponding with the detailed budget breakdown. 


 Budget calculations are clearly explained where appropriate (e.g. daily/salary rates, 
number of hours). 


 A signed resolution is attached to this application or will be provided to the Agency 
within two weeks of submitting this application. 


 Section 8 (Certification Declaration) is complete. 


 


 


Send us your application and any supporting documents by one of 
the following ways: 


• Email to:   PFP.PAFP@ceaa-acee.gc.ca 


• Facsimile: (613) 948-9172 


• Mail to: Participant Funding Program 
Canadian Environmental Assessment Agency 
160 Elgin Street, 22nd Floor 
Ottawa, ON   K1A 0H3 



mailto:PFP.PAFP@ceaa-acee.gc.ca
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Introduction  
The Participant Funding Program (PFP) supports public and Aboriginal participation in 
environmental assessments conducted by the Canadian Environmental Assessment Agency 
(the Agency), by review panels and joint review panels pursuant to the Canadian 
Environmental Assessment Act, 2012 (CEAA 2012). The PFP is administered by the Agency. 


The application form is a PDF smart form that modernizes and streamlines the process for 
entering application data.  


This document describes how the PDF smart form works and how to fill it out.  


The forms work best on Adobe Reader 10 or 11. To get a free copy, go to www.adobe.com. 
Instructions on how to download and install the software are included on the Adobe website.  


Finding Documentation  
The PDF Funding Application Form incorporates all the documents you need to help you 
complete and submit it, including:  


• How to Use Adobe Forms (this document)  


• Appendix A – What Needs to be Included in a Resolution 


• Appendix B – Content and Expense Category Description 


• Appendix C – Checklist for Completing the Funding Application Form 


• Participant Funding Program National Program Guidelines  


To find PFP program documents:  
1. Go to the first page of the PDF and 


click the   
button. A JavaScript Window will 
appear.  


2. Select a topic from the list and 
click OK to open the document 
with information on the topic. 


 


 


 


 


 


 


For more information on the PFP:  


• Refer to the Agency’s website: http://www.ceaa-acee.gc.ca/default.asp?lang=En 


• Refer to the Participant Funding Program webpage at: http://www.ceaa-
acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1, or  


• Contact your Agency regional office  



http://www.ceaa-acee.gc.ca/default.asp?lang=En

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1
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Completing Adobe Forms  
Using Common Form Elements  


This table briefly describes common features in a PDF form and how to use them. 


Form Element Description Instruction 


 


Dropdown list and scroll bar for 
selecting pre-determined input 
data 


Click the down arrow to 
see the list.  


Click the up or down 
arrow to scroll or click 
and drag the slider in 
the scroll bar.  


Click an item in the list 
to select it.  


 Check boxes are used for 
selecting multiple options. 


Select the boxes that 
apply. You can select 
more than one. 


 Radio buttons are used for 
selecting single options. 


When some options are 
selected, another row of 
information to be completed 
may be added to the form, or a 
section of the form may be 
removed automatically. 


Click the radio button 
that applies. 


 A tool to display all the documents you need to help you 
complete and submit the application form.  


This button is only available on the first page of the form.  


 A tool to add a new expense 
type to the form. 


Click to display a new 
expense section and 
enter details. 


 A tool to remove this expense 
type record from the form. 


Click to remove this 
expense type record 
from the form. 


 A tool to attach a document to 
the Application Form for 
submission. It appears when 
you choose “Attach to PDF” as 
the Method of Submission. 


Click to attach 
Supporting Documents 
to the PDF. 


 
A tool to assist in the 
submission of an Application. 


Click to Submit the 
Application. 


 
A tool to find errors prior to the 
submission of an Application. 


Click to view errors 
caught by the Smart 
Form. 
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Understanding Blue Highlights  


The Application Form uses an Adobe Reader feature that highlights active fields. To turn 
highlights on and off, click the  button in the top, right-hand corner of Adobe 


Reader.  


If a field is highlighted in blue, it is an active field and you can enter information into it. 
Click in the blue area to place the cursor in the field and enter information. To continue, 
press Tab or click the next field.  


Advancing Pages  


The pages of the form only advance when you make them do so. They do not automatically 
advance when you complete the fields on a page.  


To view the distinct pages of the form as a continuous scroll, set the View options 
in Adobe Reader as follows:  


1. From the View menu, select Page Display.  


2. Click Enable Scrolling.  


3. Click Show Gaps Between Pages.  


 


Navigating the Pages  


1. Click the Page Up or Page Down arrows  in the Adobe Reader toolbar.  


2. Use the up arrow  or down arrow  of the scrollbar on the right-hand side of 
Adobe Reader.  







Participant Funding Program  How to Use Adobe Forms 


  Page 4 of 9 


 


Showing and Hiding Details in Form Sections  


When you see a blue plus sign (+) in the form, it means that there are additional, related 


fields that need to be completed. Click it to show details and view and edit the fields.  


When you see a blue minus sign (–) in the form, it means that you can hide details from 


view. The symbol changes to a blue plus sign (+).  


Adding and Removing Items  


When asked to provide information on the form such as expenses, where you need to build 
a list of everything you want to include, the form will present one row to start with and let 
you add as many rows as you need. Click   to increase the number of rows.  


As you develop your report, you may need to make corrections. The Application Form allows 
you to remove fields and rows as needed. Click  to delete the row or section.  


Warning: Be very careful when you use this feature. There is no Undo option.  


Formatting Text  


Narrative fields where you enter descriptions and explanations can have custom formatting 
applied to them. For example, you may want to change the default font in the PDF form 
(Times New Roman) to Arial, format the text in bold or italics, or create numbered or 
bulleted lists.  


To create the formatting you want, either compose the text in another application and copy 
it into the PDF, or enter the text into the form and format it using Adobe Reader features.  


To paste pre-formatted text in PDF forms:  


1. Compose your text in another application such as MS Word and format it as required.  


2. Highlight and copy the text.  


3. Go to the section of the PDF you want to complete.  


4. Paste the text.  


Note: If the formatting does not copy over exactly as it was originally, use Adobe Reader 
formatting features to correct it.  


To format text using Adobe Reader features:  


1. Enter text in a field and select the text that you want to format.  


2. Right-click the mouse to display the following pop-up menu.  
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Note: If this pop-up menu does not appear, the formatting features are not available for 
this field.  


3. Select Text Style to access basic formatting tools, then select a formatting control. 
Alternatively, select Hyperlink from the pop-up menu to access a wide range of formatting 
controls such as you would find in a word processor. 


 


4. To modify text, click the Font tab.  
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5. To modify alignment, indents and spacing, click the Paragraph tab.  


 


 


6. Make changes as required and click Close.  
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Supporting Documents 
Attach a Supporting Document 


The Application Form includes a section for attaching supporting documents. 


1. In the Supporting Documents section, choose Attached to PDF as the method of 
submission. 


 


 


 


 


2. Click  


3. Select the file to import and click Open. 


 


4. The name of the document appears in the table. 


 


5. Save the PDF. 
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View Supporting Documents and Attachments  


This section describes how to view supporting documents that have been attached to a PDF.  


1. From the View menu, select Show/Hide → Navigation Panes → Attachments.  


 


2. In the Adobe Reader navigation panel, to show the list of Attachments, click . 


 


3. To open an attachment, double-click an attachment name.  


4. To close the list of attachments, click . 


 


Printing Forms  
You can print the Application Form showing all fields on the PDF.  


1. To show the system print dialogue, select the File → Print menu item or click .  


2. Print as usual.  
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View PDF Errors 
1. Go to the first page of the Application Form and click  


A JavaScript Window will appear.  


2. To immediately go to the field in the Application Form where the error has been 
flagged, select a topic from the list and click Go to Field. 


 


3. The field is highlighted in the Application Form. 


 


4. Correct the error. When you move to the next field, the highlighting disappears. 
Resave your form. 


 


Submit the Application Form  
1. Once all fields have been completed, submit the Application by clicking 


 on the first page of the Application Form. 


 


2. If any mandatory fields are missing, the following message appears: 


 


3. Correct the errors and re-submit. 
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Disclaimer These Guidelines are intended for information purposes only. They are not a 


substitute for the Canadian Environmental Assessment Act, 2012 


(CEAA 2012) or any of its regulations. In the event of any inconsistency 


between these Guidelines and CEAA 2012 or its regulations, the CEAA 2012 


or regulations would prevail. 


To ensure that you have the most up-to-date versions of CEAA 2012 and its 


regulations, please consult the Department of Justice website. 


Updates This document may be reviewed and updated periodically. To ensure that 


you have the most up-to-date version, please consult the Policy and 


Guidance page of the Canadian Environmental Assessment Agency’s 


website. 


Copyright © Her Majesty the Queen in Right of Canada, represented by the Minister of 


the Environment, (2015). 


This publication may be reproduced for personal or internal use without 


permission, provided the source is fully acknowledged. However, multiple 


copy reproduction of this publication in whole or in part for purposes of 


distribution requires the prior written permission by contacting. The 


Canadian Environmental Assessment Agency or info@ceaa-acee.gc.ca. 


Catalogue No.: En106-60/2013E-PDF 


ISBN: 978-1-100-21675-1 


This document has been issued in French under the title: 


Programme d'aide financière aux participants – Lignes directrices nationales 


du programme 



http://www.laws.justice.gc.ca/eng/acts/C-15.21/index.html

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=F1F30EEF-1

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=F1F30EEF-1

mailto:info@ceaa-acee.gc.ca
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Introduction 


The Participant Funding Program (PFP) supports public and Aboriginal participation in 


environmental assessments conducted by the Canadian Environmental Assessment Agency 


(the Agency), by review panels and joint review panels pursuant to the Canadian 


Environmental Assessment Act, 2012 (CEAA 2012). The PFP is administered by the Agency. 


CEAA 2012 sets out the roles and responsibilities and procedures for environmental 


assessments. Sections 57 and 58 of CEAA 2012 require the Agency to establish a participant 


funding program to facilitate the participation of the public in the environmental 


assessments it conducts and environmental assessments that have been referred to review 


panels. 


The purpose of this document is to describe the PFP components and process, and the roles 


and responsibilities of successful applicants. 


Individuals, incorporated not-for-profit organizations and Aboriginal groups interested in 


participating in a federal environmental assessment are eligible to apply for participant 


funding in one of two funding components: 


 Regular Funding: provides limited financial assistance to individuals, incorporated not-


for-profit organizations, and Aboriginal groups to help prepare for and participate in 


key public participation opportunities provided during environmental assessments by 


the Agency, review panels or joint review panels. 


 Aboriginal Funding: provides limited funding to Aboriginal groups to assist them to 


prepare for and participate in Aboriginal consultation activities and key participation 


opportunities associated with environmental assessments by the Agency, review panels 


or joint review panels. Aboriginal groups in receipt of funding from this component for 


a specific environmental assessment process are not eligible for participant funding 


under the Regular Funding for the same process. 


The funding made available by the Agency’s PFP supports public participation opportunities 


posted on the Agency’s website and Aboriginal consultation opportunities described in 


specific Aboriginal consultation plans established for a project. 


The Agency receives a fixed annual budget for the PFP and administers it to provide limited 


financial contributions to eligible applicants in a fair and transparent manner. The Agency is 


not able to cover all expenses incurred and participants are encouraged to investigate other 


sources of funding or in-kind support. 


Objective 


The overall objective of the PFP is to encourage effective participation by helping to ensure 


that concerns about the potential effects of a project on the environment, Aboriginal groups 


and on existing or potential Aboriginal or Treaty rights are taken into consideration during 


the environmental assessment process. 


Effective participation can: 


 provide individuals and organizations with an opportunity to contribute to the planning of 


projects that may affect them; 


 allow proponents and the Agency to better understand and address public interest and 


concerns regarding the potential environmental effects of a project; 



http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=D75FB358-1
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 assist in identifying and preventing or mitigating potential adverse environmental effects 


by contributing community knowledge and Aboriginal traditional knowledge that may be 


applied in the environmental assessment; and 


 inform the environmental assessment process and the decisions that come out of that 


process. 


Funding is made available by way of the PFP in support of achieving these benefits. 


Program Process 


Client Service Standards 


The Agency’s PFP client service standards for an environmental assessment by the Agency 


or by review panel are outlined below: 


Process Phases Standard Notes/Comments 


Application period 30 days 
In calendar days. May vary in 
some exceptional circumstances 


Review Applications 1 to 3 days  


Conducting Funding Review Committee and 


obtaining client revisions/additional 
documents as required 


1 to 5 days 
May vary depending on client’s 
response time 


Allocations Decision process 5 to 15 days  


Signing of Agreement by the Agency once 


received from recipient 
1 to 3 days  


Payments processing (once complete 
expense claim is received) 


10 to 20 days  


TOTAL 48 to 76 days*  


*In working days, except for the Application period. 


Determination of Funding 


Participant funding is available when a project is undergoing an environmental assessment 


by: 


 the Agency; or 


 a review panel/joint review panel. 


There is no amount of funding determined per assessment, but rather per affected group 


and for the public. The Agency has pre-established maximum funding levels for each 


recipient so that the same amount is available to all applicants for all projects and in any 


region. 


Environmental Assessment by the Agency 


An environmental assessment may be required for projects described in the Regulations 


Designating Physical Activities. Once the Agency has posted a notice on its Canadian 


Environmental Assessment Registry website that an adequate project description has been 


received from a proponent, the Agency must determine within 45 days whether an 


environmental assessment is required. If an environmental assessment is required, it is 


initiated as an environmental assessment by the Agency.  



http://laws-lois.justice.gc.ca/eng/regulations/SOR-2012-147/index.html

http://laws-lois.justice.gc.ca/eng/regulations/SOR-2012-147/index.html

http://www.ceaa-acee.gc.ca/050/index-eng.cfm

http://www.ceaa-acee.gc.ca/050/index-eng.cfm
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The environmental assessment process begins with a comment period on the draft 


Environmental Impact Statement Guidelines. The availability of participant funding is 


announced approximately 30 days after the close of the comment period on the draft 


Environmental Impact Statement Guidelines. 


Participant funding during an environmental assessment by the Agency is available to 


support the participant in: 


 reviewing and providing written comments to the Agency on the Environmental Impact 


Statement Summary or Environmental Impact Statement produced by the proponent; 


and  


 reviewing and providing written comments on the draft Environmental Assessment 


Report prepared by the Agency. 


Environmental Assessment by a Review Panel / Joint Review Panel 


The Minister of the Environment may refer the environmental assessment of a project to a 


review panel within the first 60 days of the environmental assessment. During this period, 


the environmental assessment is commenced by the Agency as described in the previous 


section. 


The availability of participant funding is announced at the beginning of the review panel 


process. 


Participant funding in an environmental assessment by a review panel/joint review panel is 


available to support the participant in: 


 reviewing and providing written comments to the Agency on the draft terms of 


reference; 


 reviewing and providing written comments to the Agency and/or review panel on the 


Environmental Impact Statement Summary or Environmental Impact Statement 


produced by the proponent; and 


 preparing for and participating in the hearings held by the review panel. 


In the Aboriginal Funding component only, funding can be made available to support 


Aboriginal consultation on the review panel’s report. 


Regular Funding Level 


The maximum funding available for public participation in environmental assessments 


undertaken by the Agency is $10,500. And the maximum funding available for public 


participation in environmental assessments undertaken by a review panel/joint review panel 


is $20,000. 


Aboriginal Funding Level 


In considering what constitutes a reasonable contribution to Aboriginal groups to support 


their input to an environmental assessment and/or to support their engagement in 


consultation activities with the federal government, the Agency recognizes three categories 


in which activities may need to be undertaken by Aboriginal groups: 


 Community consultation: discussions within the Aboriginal community on a project and 


its potential effects on the environment and Aboriginal or Treaty rights, so views and 


information can be gathered and brought forward during the environmental assessment 


process and consultation activities; 







Participant Funding Program  National Program Guidelines 


  Page 4 of 8 


 


 Technical review and input: review of the technical documents prepared during the 


environmental assessment process and input on those documents; and 


 Consultation with federal government: presentation of the views of the Aboriginal group 


to the federal government. 


Based on the opportunities for participation and consultation during the environmental 


assessment process identified in the consultation work plan, the funding to be offered in 


support of the activities described above is identified by the Agency using pre-established 


maximum funding levels. 


Notification of Availability of Funding 


Notification of Regular Funding Availability 


To notify the public that participant funding is available, the Agency places public notices in 


local media and distributes a news release to provincial media outlets. The news release and 


public notice are also made available on the Agency’s Canadian Environmental Assessment 


Registry website. 


Notification of Aboriginal Funding Availability 


Aboriginal Funding is directly linked to the Agency’s Aboriginal consultation activities 


associated with the environmental assessment of a project. Aboriginal Funding availability is 


communicated by the Agency directly to those Aboriginal groups involved. This is done at 


the same time as the announcement for Regular Funding. 


Eligible Recipients 


Eligible Recipients 


Individuals, incorporated not-for-profit organizations and Aboriginal groups may apply for 


participant funding. 


To be eligible to apply, participants must demonstrate the value they will add by their 


participation in the environmental assessment and that they meet at least one of the 


following criteria: 


 Have a direct, local interest in the project, such as living or owning property in the 


project area; 


 Have community knowledge or Aboriginal traditional knowledge relevant to the 


environmental assessment; 


 Plan to provide expert information relevant to the anticipated environmental effects of 


the project; and/or 


 Have an interest in the potential impacts of the project on treaty lands, settlement lands 


or traditional territories and/or related claims and rights. 


Ineligible Recipients 


Governmental organizations, other than Aboriginal governments, are not eligible to receive 


participant funding. 



http://www.ceaa-acee.gc.ca/050/index-eng.cfm

http://www.ceaa-acee.gc.ca/050/index-eng.cfm
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Any individuals, organizations or groups with views regarding the potential environmental 


effects of a project may still participate in the environmental assessment process, 


regarless of funding decisions. 


Expenses 


Eligible Expenses 


The following expenses are eligible for funding under the PFP (for more detailed guidance 


see Appendix B - Content and Expense Category Description of the Application Form): 


 Reporting Costs1 


 Professional Services2  


 Travel Expenses (including travel kilometers/flights, meals, incidentals and 


accommodation) 


 Honoraria for Elders and ceremonial offerings (including costs associated with providing 


Aboriginal traditional or community knowledge relevant to the environmental 


assessment. The Elder cannot be in receipt of a salary or any other direct income 


for the activity for which an honorarium is claimed. Ceremonial offerings include 


relevant costs associated with providing gifts, such as tobacco offered to the Elder(s), in 


recognition for provided Aboriginal or community knowledge relevant to the 


environmental assessment.) 


 


To qualify for reimbursement, all costs must be attributed to these expense categories and 


must directly contribute to activities described in the approved work plan (Appendix B of a 


Contribution Agreement). 


Ineligible Expenses 


The PFP will not fund activities that duplicate services, studies or written materials that are 


funded by other public or private sources. This includes information prepared by the 


Agency, the proponent or, in the case of an assessment by a review panel, the review 


panel. 


Applicants must identify, in their application, any other sources of funding assistance 


provided by any level of Government for the specific project. If it is determined that 


expenses were already covered by another source of funding, then the Agency might ask for 


reimbursement of those funds. 


Participant funding is not available to support review and comment on the draft 


Environmental Impact Statement Guidelines. 


                                           


1
 Includes: staff salaries, administrative/reporting costs (such as: bookkeeping, accounting, reporting 


on the deliverables specific to the project for which the funding is provided) and office supplies, 
telephone charges, rental of office space, meeting rooms, local collection/distribution of information, 
general media advertising, promotion and other expenses. 


2
 Includes: professional fees (expert advice or assistance on environmental, technical, or social issues 


relevant to the objectives of the Environmental Assessment) and legal fees (expert legal advice or 
assistance directly related to the recipient’s participation). 



http://www.ceaa-acee.gc.ca/default.asp?lang=En&n=E33AE9FB-1
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Application Submission 


A completed funding application form must be submitted by the deadline to be considered 


for funding. The application forms are available on the Agency’s website. 


The deadline for submitting a funding application is generally 30 days from the notification 


of Regular and Aboriginal Funding availability, and is clearly identified in the Public Notices 


and News Releases. 


Only completed application forms received by the deadline will be considered. 


Completed applications and supporting documentation are to be submitted to the Agency by 


one of the following ways: 


 


 Email to:  PFP.PAFP@ceaa-acee.gc.ca 


 Mail to:  Participant Funding Program 


 Canadian Environmental Assessment Agency 


 160 Elgin Street, 22nd Floor 


 Ottawa, ON   K1A 0H3 


Application Assessment 


A Funding Review Committee reviews all applications received to determine whether the 


proposed activities align with the public participation and Aboriginal consultation 


opportunities set out by the Agency and determines if the associated expenses reflect the 


effort and resources required to support those activities. Based on that analysis, the 


Funding Review Committee recommends whether funding should be approved, and if so, 


recommends an appropriate amount for each applicant to the President of the Agency, who 


makes the final decision on each funding request. 


Funding 


The President of the Agency makes the final decision on the funding allocations based on 


the Funding Review Committee’s report and recommendations, and any additional 


considerations identified by the Agency. 


Some applicants may not receive funding. Others may be approved for less than the 


amount they requested. Regardless of the decision, applicants may still participate in the 


environmental assessment. 


The Agency notifies applicants of the President’s funding decision. The successful applicants’ 


names and approved funding allocation amounts are made public on the Agency’s Media 


Room and on the Agency’s website for any funding allocations of over $25,000 as part of 


the Government of Canada’s efforts of transparency.  


Contribution Agreement 


When funding is approved, the applicant will be contacted by the Agency to finalize a 


Contribution Agreement. A Contribution Agreement is a type of contract between the 


Agency and a recipient of the funds. A sample Contribution Agreement is available on the 


PFP webpage. 



http://www.ceaa-acee.gc.ca/default.asp?lang=En&n=E33AE9FB-1

http://www.ceaa-acee.gc.ca/default.asp?lang=En&n=E1A6C896-1

http://www.ceaa-acee.gc.ca/default.asp?lang=En&n=E1A6C896-1

mailto:PFP.PAFP@ceaa-acee.gc.ca

http://www.ceaa-acee.gc.ca/default.asp?lang=En&n=C0A8F3B6-1

http://www.ceaa-acee.gc.ca/default.asp?lang=En&n=C0A8F3B6-1

http://www.ceaa-acee.gc.ca/gc-sc/index.cfm?lang=en

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1
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The Contribution Agreement, signed by the applicant (referred to in the Contribution 


Agreement as the “Recipient”) and the Agency, will identify the conditions of the funding 


and the obligations of all signatories.  


Only expenses incurred after a Contribution Agreement has been signed by both the 


Recipient and the Agency can be reimbursed. 


The Contribution Agreement also: 


 identifies the eligible costs; 


 specifies the eligible activities in the approved work plan; 


 specifies conditions for payment; 


 specifies the effective date and duration of the Contribution Agreement; and 


 requires the Recipient to be accountable for the public funds received. 


Due to the estimated nature of funding requests, an adjustment of up to 20 percent within 


expense categories may be allowed. The Recipient must submit a written request with 


justification to modify the original eligible expenditures approved as part of Appendix A of 


the Contribution Agreement. The request must be approved by the Agency and the total 


amount claimed must remain within the level of funding originally approved. 


The Agency reserves the right to undertake, or have undertaken, a financial audit of the 


accounts and resources of the recipient to ensure compliance with the provisions of the 


Contribution Agreement. 


Direct Deposit 


The Government of Canada is switching from cheques to direct deposit, an electronic 


transfer of funds deposited directly into your bank account. The direct deposit will be faster 


than cheques. For more information on direct deposit, visit your bank or financial institution, 


or call toll-free at 1-800-O-Canada (1-800-622-6232). You can also find more information, 


including a short informative video, at Public Works and Government Services Canada’s 


website. 


If you currently have a bank account or qualify to open a bank account, you are encouraged 


to enroll by completing the Recipient Registration and Electronic Payment Request Form and 


returning it to the Agency by one of the following ways: 


 


 Email to:  PFP.PAFP@ceaa-acee.gc.ca 


 Facsimile:  613-948-9172 


 Mail to:  Participant Funding Program 


 Canadian Environmental Assessment Agency 


 160 Elgin Street, 22nd Floor 


 Ottawa, ON   K1A 0H3 


 


 


Payments 


The Contribution Agreement includes conditions of payment. There are two ways that funds 


can be provided to the Recipient: as interim payments or a final payment. A Detailed 


Financial Report form can be downloaded from the Agency’s website. 



http://www.tpsgc-pwgsc.gc.ca/recgen/txt/depot-deposit-eng.html

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1

mailto:PFP.PAFP@ceaa-acee.gc.ca

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1

http://www.ceaa-acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1
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Interim 


An interim payment can be made after some eligible expenses have been incurred by the 


Recipient for participation activities set out in the approved work plan, but before all 


activities relating to the final participation opportunity have been completed.  


Final 


A final payment claim can be submitted once all of the eligible expenses related to the final 


participation opportunity have been incurred by the Recipient and when there are no more 


opportunities to participate in the environmental assessment. 


Contact Information 


Visit the Agency’s website for further information on the PFP at http://www.ceaa-


acee.gc.ca/default.asp?lang=en&n=E33AE9FB-1. 


You can also write to: 


Participant Funding